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TIBCO Documentation and Support Services

Documentation for this and other TIBCO products is available on the TIBCO Documentation site. This
site is updated more frequently than any documentation that might be included with the product. To
ensure that you are accessing the latest available help topics, please visit:

https://docs.tibco.com
Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site. To directly access documentation for this product, double-click the
following file:

TIBCO_HOME/release_notes/TIB_bwpluginjde_version_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows,
the default TIBCO_HOME is C:\Program Files\tibco. On UNIX systems, the default TIBCO_HOME

is /opt/tibco.

The following documents for this product can be found on the TIBCO Documentation site:

e TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne Installation
e TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne User’s Guide
e TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne Release Notes

How to Contact TIBCO Support
For comments or problems with this manual or the software it addresses, contact TIBCO Support:

* For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

* If you already have a valid maintenance or support contract, visit this site:
https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCO Community

TIBCO Community is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCO Community offers
forums, blogs, and access to a variety of resources. To register, go to the following web address:

https://community.tibco.com
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https://docs.tibco.com
http://www.tibco.com/services/support
https://support.tibco.com
https://community.tibco.com

Product Overview

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne provides the service of
message exchange between TIBCO ActiveMatrix BusinessWorks™ applications and the JD Edwards
EnterpriseOne enterprise resource planning (ERP) system. The plug-in supports business function calls,
extracting data using query lists, and publishing real time events that interoperate with the JD Edwards
EnterpriseOne system.

JO Edwards

EnterpriseCne
JD Edwards Plug-in
EnterpriseCne

TIBCO ActivelMatrix
BusinessWorks

TIBCO TIBCO Enterprise
Business Studio Administrator

The following list describes each item and the relationship between them in the previous figure.

e JD Edwards EnterpriseOne is an integrated application suite of comprehensive enterprise resource
planning software, which combines business values, standards-based technology, and deep
industry experience into a business solution.

e TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne is plugged into TIBCO
ActiveMatrix BusinessWorks and is connected to JD Edwards EnterpriseOne.

¢ TIBCO ActiveMatrix BusinessWorks is an easy-to-use integration product suite for enterprise
applications.

e TIBCO Business Studio™ is the graphical user interface (GUI) used by TIBCO ActiveMatrix
BusinessWorks and the plug-in to design business processes, and the process engine used to execute
them.

+ TIBCO" Enterprise Administrator provides a centralized administrative interface to manage and
monitor the plug-in applications deployed in an enterprise.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide



Getting Started

This tutorial is designed for the beginners who want to use TIBCO ActiveMatrix BusinessWorks Plug-
in for JD Edwards EnterpriseOne in TIBCO Business Studio.

All the operations are performed in TIBCO Business Studio. See TIBCO Business Studio Overview to
get familiar with TIBCO Business Studio.

A basic procedure of using TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne
includes:

Creating a Project

Creating a JDE Connection

Configuring a Process

Testing a Process

S

Deploying an Application

Creating a Project

The first task using the plug-in is creating a project. After creating a project, you can add resources and
processes.

An Eclipse project is an application module configured for TIBCO ActiveMatrix BusinessWorks. An
application module is the smallest unit of resources that is named, versioned, and packaged as part of
an application.

Procedure

1. Start TIBCO Business Studio using one of the following ways:

*  Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers.

. Mac OS and Linux: run the TIBCO Business Studio executable file located in the TTBCO_HOME/
studio/version_number/eclipse directory.

2. From the menu, click File > New > BusinessWorks Resources to open BusinessWorks Resource
Wizard.

3. In the "Select a wizard" dialog, click BusinessWorks Application Module and click Next to open
the New BusinessWorks Application Module wizard.

4. In the Project dialog, configure the project that you want to create:
a) In the Project name field, enter a project name.

b) By default, the created project is located in the workspace currently in use. If you do not want to
use the default location for the project, clear the Use default location check box and click Browse
to select a new location.

c) Use the default version of the application module, or enter a new version in the Version field.

d) Keep the Create empty process and Create Application check boxes selected to automatically
create an empty process and an application when creating the project.

e) Select the Use Java configuration check box if you want to create a Java module.
A Java module provides the Java tooling capabilities.
f) Click Finish to create the project.

Result

The project with the specified settings is displayed in the Project Explorer view.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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Creating a JDE Connection

After creating a project, you have to create a JDE Connection shared resource to connect to the JD
Edwards EnterpriseOne server.

Prerequisites

The JDE Connection shared resource is available at the Resources level. Ensure that you have created a
project as described in Creating a Project.

Procedure

Expand the created project in the Project Explorer view.

2. Right-click the Resources folder and click New > JDE Connection to open the JDE Connection
wizard.

3. The resource folder, package name, and resource name of the JDE Connection shared resource are
provided by default. If you do not want to use the default configurations, change them accordingly.
Click Finish to open JDE Connection Editor.

4. Configure the JDE Connection shared resource in JDE Connection Editor.
See JDE Connection regarding the configuration fields.

5. Click Test Connection to validate the connection.

Configuring the INI File

Before configuring a JDE Connection share resource, you must configure the parameters in the
jdeinterop.ini file.
Complete the following steps to configure the jdeinterop.ini file:

Procedure

1. Copy the jdeinterop.ini. templ file in the system\classes\samples\ConnectorSamples.zip
\config directory from the JD Edwards EnterpriseOne server to the machine where the plug-in is
installed, and then change the file name to jdeinterop.ini.

2. Copy the jdbj.ini file in the system\classes\samples\ConnectorSamples.zip\config
directory from the JD Edwards EnterpriseOne server to the machine where the plug-in is installed.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide



3. Copy the database configuration file that is used to connect to the database from the JD Edwards
EnterpriseOne server to the machine where the plug-in is installed. The configuration file varies
depending on the JDBC database used. For example, if an Oracle database is used, the configuration
file is tnsnames. ora located in the <database-home>\dbhome_1\network\admin directory.

4. Copy the content in the jdbj.ini file to the jdeinterop.ini file.

5. Configure the jdeinterop.ini file according to the JD Edwards EnterpriseOne system which the
plug-in connects to.

6. Save the file.

Configuring a Process
After creating a project, an empty process is created. You can add activities to the empty process to
complete a task, such as invoking a business function to handle incoming requests.

Prerequisites

Ensure that you have created an empty process when creating a project. See Creating a Project for more
information.

Procedure

1. In the Project Explorer view, click the created project and open the empty process from the
Processes folder.

2. Select activities from the Palette view and drop them in the Process editor.
For example, select and drop the Timer activity from the General Activities palette, and the
CallBusinessFunction activity from the JDE palette.

[ Project Explorer 52 = O ||fDE |8 Process.bwp i
2% e de.Process
4 B JDE =
b < Processes

[5; Service Descriptors
(& Resources
{@ Schemas
Bl Policies
4 1+ Module Descriptors
Jfk Overview
=4 Module Properties Timer CallBusinessFunction
2 Dependencies
£ Components
Shared Variables
[cts build.properties
[ ﬁ IDE.application

3. Click an activity in the Process editor and drag the (") icon to create a transition between the
added activities.

4. Configure the added JDE activities, as described in JDE Palette.

5. Click File > Save to save the process.

Testing a Process

After configuring a process, you can test the process to check if the process completes your task.
Prerequisites

Ensure that you have configured a process, as described in Configuring a Process.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide



Procedure

1. Open the process you have configured in TIBCO Business Studio.

2. On the toolbar, click | %% = Debug > Debug Configurations.
3. Click BusinessWorks Application > BWApplication in the left panel.

By default, all the applications in the current workspace are selected in the Applications tab. Ensure
that only the application you want to debug is selected in the Applications tab in the right panel.

4. Click Debug to test the process in the selected application.

TIBCO Business Studio changes to the Debug perspective. The debug information is displayed in
the Console view.

5. In the Debug tab, expand the debugged process and click an activity, such as the
CallBusinessFunction activity.

6. In the upper-right panel, click Job Data view, and then click the Output tab to check the activity

output.
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e
</jdeResponse>

14:29:31.852 INFO [pool-S-thread-1] c.t.b.p.j.r.CallBusinessFunctionhctivity - TIBCO-BW-PALETTE-JDE-320001: Begin to generate the oucput data.
14:29:31.870 DEBUG [pool-5-thread-1] c.t.b.p.j.r.CallBusinessFunctionBerivity - TIBCO-BW-PALETTE-JDE-360005: Generate CallBusinessFunction Actiwity output data:<nsO:Act
14:29:31.870 INFO [pool-$-thread-1] c.t.b.p.j.r.CallBusinessFunctionhctivity - TIBCO-BW-PALETTE-JDE-320002: End to generate the output data.

Deploying an Application

After testing, if the configured process works as expected, you can deploy the application that contains
the configured process into a runtime environment, and then use the bwadmin utility to manage the
deployed application.

Before deploying an application, you must generate an application archive, which is an enterprise
archive (EAR) file that is created in TIBCO Business Studio.

Deploying an application involves the following tasks:

1. Uploading an application archive
2. Deploying an application archive

3. Starting an application

See TIBCO ActiveMatrix BusinessWorks Administration for more details on how to deploy an application.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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TIBCO Business Studio Overview

TIBCO Business Studio is an Eclipse-based integration development environment that is used to
design, develop, and test ActiveMatrix BusinessWorks applications.

TIBCO Business Studio provides a workbench in which you can create, manage, and navigate resources
in your workspace. A workspace is the central location on your machine where all data files are stored.

File Edit Diagram Mavigate Search Project Run Window Help | |
= = —— - — -
oG e B E-er-0-C-=o~ = o T oy 5 3
Segoe Ul o VIBIlA-® gy o[ BirRy || xr|[100% o s | [ Besign
135 Project Explorer &2 | =) %\ P G *Ca\\husinassfunmnn bwp 52 (=]
B J0E - % Palette b
& IDE.application jde Callbusinessfunction =
kRS-
r=
@
4
Recently Used )
4 Favorite Paleites <)
B PaletteLibary %
Timer CallBusinessFunction 0 -
CallBusinessFunction
MonitorRealTime
QueryXMLList
o = = =
5= Outl.. | & Dep... | @ Mod... [ File.. &2 O [T= Properties| 21 Problems 52 | (2) BW Help| B Consale >0
& FEO® 7 |otems
~ [ DAbwE\bw\6.3\samples Description Resource Path Location Type
(= binding
& bws
= core
= palette 4
= plugins
= policy
(= scenario
(= source

The workbench consists of:

e Menu: contains menu items such as File, Edit, Diagram, Navigate, Search, Project, Run, Window,
and Help.

« Toolbar: contains buttons for frequently used commands such as New |[*| *|, Save ||, Enable/

L

Disable Business Studio Capabilities |[isf| |, Create a new BusinessWorks Application Module |, |,
Create a new BusinessWorks Shared Module |[£] |, Debug | %% |, Run | {3 =, and so on.

* DPerspective: contains an initial set and layout of views that are required to perform a certain task.
TIBCO Business Studio launches the Modeling perspective by default. You can change the
perspective from the menu Window > Open Perspective > Perspective_Name.

* View: displays resources. For example, the Project Explorer view displays the ActiveMatrix
BusinessWorks applications, modules, and other resources in your workspace, and the Properties
view displays the properties for the selected resource. You can open a view from the menu Window
> Show View > View_Name.

e Editor: provides a canvas to configure, edit, or browse a resource. Double-click a resource in a view
to open the appropriate editor for the selected resource. For example, double-click an ActiveMatrix
BusinessWorks process (Callbusinessfunction.bwp) in the Project Explorer view to open the
process in the editor.

o Palette: contains a set of widgets and a palette library. A palette groups activities that perform
similar tasks and provide quick access to activities when you configure a process.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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JDE Connection

The JDE Connection shared resource contains all the necessary parameters that have to be configured
when you use TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne to connect to
the JD Edwards EnterpriseOne server. The JDE Connection shared resource is used by all the activities
in the JDE palette.

General

The following table describes the fields in the General panel:

Module
Property?  Description
Package No The name of the package where the shared resource is added.
Name No The name to be displayed as the label for the shared resource in the
process.
Description No A short description for the shared resource.

JDE Connection Configuration

The following table describes the fields in the JDE Connection Configuration panel:

Module

Property? Description

Server Name Yes The host name or the IP address of the machine that hosts the
JD Edwards EnterpriseOne application server which TIBCO
ActiveMatrix BusinessWorks Plug-in for JD Edwards
EnterpriseOne connects to.

Port Number Yes The port number that is used to establish connection between
the JD Edwards EnterpriseOne server and TIBCO ActiveMatrix
BusinessWorks Plug-in for JD Edwards EnterpriseOne.

Environment Yes The environment name in JD Edwards EnterpriseOne that is
used by TIBCO ActiveMatrix BusinessWorks Plug-in for JD
Edwards EnterpriseOne.

The environment name must start with letter J, such
as JDV900.

User Name Yes The user name that is used by TIBCO ActiveMatrix
BusinessWorks Plug-in for JD Edwards EnterpriseOne to
connect to JD Edwards EnterpriseOne.

Password Yes The password for the account used by TIBCO ActiveMatrix
BusinessWorks Plug-in for JD Edwards EnterpriseOne to
connect to JD Edwards EnterpriseOne.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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Module

Property? Description

Configuration File  Yes The INT file that is used to connect to the specified JD Edwards
EnterpriseOne server.

For more details about configuring the INT file, see
Configuring the INI File.

JDE Connection Pool Configuration

The following table describes the fields in the JDE Connection Pool Configuration panel:

Module

Property? Description

MaxConnectionNum Yes The maximum number of connections that can be
established between TIBCO ActiveMatrix BusinessWorks
Plug-in for JD Edwards EnterpriseOne and JD Edwards
EnterpriseOne.

ReconnectionNum Yes The total number of reconnection attempts for TIBCO
ActiveMatrix BusinessWorks Plug-in for JD Edwards
EnterpriseOne to connect to JD Edwards EnterpriseOne.

Reconnlnterval Yes The time interval between each connection attempt.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide



13

JDE Palette

A palette groups the activities that connect the same external applications together. The JDE palette is
added to TIBCO Business Studio after installing TIBCO ActiveMatrix BusinessWorks Plug-in for JD
Edwards EnterpriseOne.

The JDE palette contains the following activities:

e (CallBusinessFunction
e  MonitorRealTime

*  QueryXMLList

CallBusinessFunction

You can use the CallBusinessFunction activity to invoke a business function or a group of business
functions to handle incoming requests in the JD Edwards EnterpriseOne system.

General

The following table describes the configurations in the General tab of the CallBusinessFunction
activity.

Module

Property? Description

Name No The name of the activity displayed in the process. The
default value is Cal1BusinessFunction.

JDE Connection Yes Select a JDE Connection shared resource by completing the
following steps:

1. Click the Choose/Create Default Resource icon to
open the "Select JdeconnectionResource Resource
Template" window, where all the available resources
are listed.

2. In the Matching items panel, click the shared resource
you want to select. Click OK.

IsGroup No Select this check box if you want to choose a group of
business functions.

BusinessFucntion Yes
Click the Choose a resource Q, icon to select one or
multiple business functions.

Description
In the Description tab, you can add a short description for the CallBusinessFunction activity.
Advanced

The following table describes the configurations in the Advanced tab of the CallBusinessFunction
activity.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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Module

Property? Description

Get Schema No Click this button to get the schema of the selected business
function. The schema is displayed in the Input tab after
clicking this button.

Name No The name of the selected business function.

IsLoop No Select this check box if you want the business function to be
called multiple times in a business function group. This check
box is only used by business function group.

Use Attribute No Select this check box if you want to use the attribute as an
input parameter for the selected business functions.

Use Bind No Select this check box if you want to use the output parameter
of the business function as the input parameter of the
subsequent business functions. This check box is only used by
business function group.

The plug-in supports passing values of output parameters of
any business functions to subsequent business functions as
the input.

Bind Identify No Enter a value for the Bind parameter. All the parameters with
the Use Bind check box selected in a preceding business
function are displayed in the list. The Bind Identify attribute
is only used by business function group.

Refresh No Click this button after you complete all the settings in the
Advanced tab to refresh the Input tab.

Input
In the Input tab, enter values in each field for your selected business functions.
Output

The following table describes the output elements in the Output tab of the CallBusinessFunction
activity.

Output Item Data Type Description

Status Boolean The status of the CallBusinessFunction activity. When the
activity runs successfully, the status is true; otherwise, the status
is false.

ID String The ID number of the returned error message after running the

CallBusinessFunction activity.

Message String The returned error message which contains information about
the CallBusinessFunction activity.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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Output Item Data Type Description
& ‘ The output items vary, depending on the business functions you select.
Fault

The following table describes the error schema elements in the Fault tab of the CallBusinessFunction

activity.

Error Schema Element Data Type Description

JDEPluginException

msg String This error message is displayed when the JD
Edwards EnterpriseOne plug-in captures an
exception for the CallBusinessFunction activity.

msgCode String This error code is displayed when the JD
Edwards EnterpriseOne plug-in captures an
exception for the CallBusinessFunction activity.

MonitorRealTime

You can use the MonitorRealTime activity to listen to the real time event that is created by the JD
Edwards EnterpriseOne system.

General

The following table describes the configurations in the General tab of the MonitorRealTime activity.

Module

Property? Description

Name No The name of the activity displayed in the process. The
default value is MonitorRealTime.

JDE Connection Yes Select a JDE Connection shared resource by completing the
following steps:

1. Click the Choose/Create Default Resource icon to
open the "Select JdeconnectionResource Resource
Template" window, where all the available resources are
listed.

2. In the Matching items panel, click the shared resource
you want to select. Click OK.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide
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Module

Property? Description

Real Time Event Yes Select a real time event by completing the following steps:

1. Click the Choose a resource Q icon; the JDE Object
List window is displayed.

2. Select an object by entering a value in the Please select
an object field to match the desired object, or by
scrolling up and down the object list. Click OK.

Description
In the Description tab, you can add a short description for the MonitorRealTime activity.
Advanced

The following table describes the configurations in the Advanced tab of the MonitorRealTime activity.

Module

Property? Description

Get Schema No Click this button to get the schema of the selected real time
event.

Name No The name of the selected real time event.

IsLoop No Select this check box to indicate that the data structure

occurs multiple times in a real time event.

Use Attribute No Select this check box if you want the attribute to be the
output in the ActiveEnterprise messages.

Refresh No Click this button after you complete all the settings in the
Advanced tab to refresh the Input tab.

Sequence Key No This field contains an XPath expression that specifies the
order in which the process runs. Process instances with
sequencing keys that have the same value are executed
sequentially in the order in which the process instances are
created.

Custom Job Id No This field contains an XPath expression that specifies a
custom job ID for every job in the process instance.

Conversations

In the Conversations tab, you can click Add New Conversation icon to initiate a conversation. A
conversation represents two or more related message exchanges in the same process that are correlated
by the BusinessWorks engine.
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Output

The following table describes the output elements in the Output tab of the MonitorRealTime activity.

Output Item Data Type Description

Status Boolean The status of receiving data by the MonitorRealTime
activity. When the activity receives data successfully,
the status is true; otherwise, the status is false.

& ‘ The output items vary, depending on the real time event you select.

Fault

The following table describes the error schema elements in the Fault tab of the MonitorRealTime

activity.

Error Schema Element Data Type Description

JDEPluginException

msg String This error message is displayed when the JD
Edwards EnterpriseOne plug-in captures an
exception for the MonitorRealTime activity.

msgCode String This error code is displayed when the JD
Edwards EnterpriseOne plug-in captures an
exception for the MonitorRealTime activity.

QueryXMLList

You can use the QueryXMLList activity to query an existed table in the JD Edwards EnterpriseOne
system.

General

The following table describes the configurations in the General tab of the QueryXMLList activity.

Module

Property? Description

Name No The name of the activity displayed in the process. The default
value is QueryXMLList.
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Module

Property? Description

JDE Connection Yes Select a JDE Connection shared resource by completing the
following steps:

1. Click the Choose/Create Default Resource icon to
open the "Select JdeconnectionResource Resource
Template" window, where all the available resources are
listed.

2. In the Matching items panel, click the shared resource you
want to select. Click OK.

Table Type No Select one of the following table types:
1. Table
2. View
3. TC
Table Name Yes Select a table name by completing the following steps:

1. Click the Choose a resource Q icon; the JDE Object List
window is displayed.

2. Select an object by entering a value in the Please select an
object field to match the desired object, or by scrolling up
and down the object list. Click OK.

Query Type No Select one of the following query types:

1. ListCreate

Creates a list in the specified Table, View or TC.
2. ListRetrieve

Retrieves a list from the specified Table, View or TC.
3. ListDelete

Deletes a list from the specified Table, View or TC.

Description
In the Description tab, you can add a short description for the QueryXMLList activity.
Advanced

The following table describes the configurations in the Advanced tab of the QueryXMLList activity.

Module

Property? Description

Get Schema No Click this button to get the schema of the selected table.
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Module

Property? Description

Name No The name of the table selected from the Table Name list in the
General tab.
Use Attribute No Select this check box if you want to use the attribute as an

input parameter for the selected table.

Refresh No Click this button after you complete all the settings in the
Advanced tab.
& If TC is selected in the Table Type field, you have to select the TC version after clicking

Get Schema in the Advanced tab.

Input
The following table describes the input elements in the Input tab of the QueryXMLList activity.
Input Item Data Type Description

The following fields are displayed when Table, or View in the Table Type list, and ListCreate in the
Query Type list are selected.

TableName String Specify the name for the table, where ListCreate operations
are performed, with single or double quotation marks.

TableType String Enter a table type, such as ONTABLE, OWVIEW, or
FOREIGN_TABLE.

DataSelection N/A Specify the data used to create a list in the specified table
under this node.

ClauseType N/A Specify the clause type under this node.

ClauseName String Enter the name for the clause with single or double
quotation marks. The clause name can be WHERE, OR, or AND.

OperationType String Enter an operation type, such as EQ, NE, or LT.

ColumnAttributes N/A Specify the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column, where ListCreate operations

are performed, with single or double quotation marks.

TableName String Enter the name for the table, where ListCreate operations
are performed, with single or double quotation marks.

Instance String Enter the instance value for the column with single or
double quotation marks.
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Input Item Data Type Description

Alias String Enter an alias for the column name with single or double
quotation marks.

Oprand N/A Specify the supported element types under this node.

LiteralValue String Enter the literal value with single or double quotation
marks.

ColumnAttributes N/A Specity the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column, where ListCreate operations
are performed, with single or double quotation marks.

TableName String Enter the name for the table with single or double quotation
marks.

Instance String Enter the instance value for the column with single or
double quotation marks.

Alias String Enter an alias for the column name with single or double
quotation marks.

OpRange N/A Specify the operand range under this node.

LiteralFrom Int Enter the starting literal value with single or double
quotation marks.

LiteralTo Int Enter the end literal value with single or double quotation
marks.

OpList N/A Specify the operand list under this node.

Literalvalue String Enter the literal value for the operand with single or double
quotation marks.

DataSequencing N/A Specify the data sequence for the specified column.

Sort String Sort the specified column in descending or ascending order,
with single or double quotation marks.

ColumnAttributes N/A Specify the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column with single or double
quotation marks.

TableName String Enter the name for the table with single or double quotation
marks.

Instance String Enter the instance value for the column with single or

double quotation marks.
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Input Item Data Type Description

Alias String Enter an alias for the column with single or double
quotation marks.

The following fields are displayed when TC in the Table Type list, and ListCreate in the Query
Type list are selected.

TCName String Specify the name for the TC, where ListRetrieve operations
are performed, with single or double quotation marks.

TCVersion String Specify the version for the TC with single or double
quotation marks.

DataSelection N/A Specify the data used to create a list in the specified table
under this node.

ClauseType N/A Specify the clause type under this node.

ClauseName String Enter the name for the clause with single or double
quotation marks. The clause name can be WHERE, OR, or AND.

OperationType String Enter an operation type, such as EQ, NE, or LT.

ColumnAttributes N/A Specify the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column, where ListCreate operations

are performed, with single or double quotation marks.

TableName String Enter the name for the table, where ListCreate operations
are performed, with single or double quotation marks.

Instance String Enter the instance value for the column with single or
double quotation marks.

Alias String Enter an alias for the column name with single or double
quotation marks.

Oprand N/A Specify the supported element types under this node.

LiteralValue String Enter the literal value with single or double quotation
marks.

ColumnAttributes N/A Specify the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column with single or double

quotation marks.

TableName String Enter the name for the table with single or double quotation
marks.
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Input Item Data Type Description

Instance String Enter the instance value for the column with single or
double quotation marks.

Alias String Enter an alias for the column name with single or double
quotation marks.

OpRange N/A Specify the operand range under this node.

LiteralFrom Int Enter the starting literal value with single or double
quotation marks.

LiteralTo Int Enter the end literal value with single or double quotation
marks.

OpList N/A Specify the operand list under this node.

LiteralvValue String Enter the literal value for the operand with single or double
quotation marks.

DataSequencing N/A Specify the data sequence for the specified column.

Sort String Sort the specified column in descending or ascending order,
with single or double quotation marks.

ColumnAttributes N/A Specify the column attributes for the specified table under
this node.

ColumnName String Enter the name for the column with single or double
quotation marks.

TableName String Enter the name for the table with single or double quotation
marks.

Instance String Enter the instance value for the column with single or
double quotation marks.

Alias String Enter an alias for the column with single or double

quotation marks.

The following fields are displayed when Table, or View in the Table Type list, and ListRetrieve in

the Query Type list are selected.

TableName String Specify the name for the table, where ListRetrieve
operations are performed, with single or double quotation
marks.

Handle String Specify the handle which is generated by the ListCreate
operation and is used to retrieve data from a list.

From String Enter a value to specify where to start retrieving data, with

single or double quotation marks.
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Description

Enter a value to specify where to end retrieving data, with
single or double quotation marks.

The following fields are displayed when TC in the Table Type list and ListRetrieve in the Query
Type list are selected.

TCName String Specify the name for the TC, where ListRetrieve operations
are performed, with single or double quotation marks.

Handle String Specify the handle which is generated by the ListCreate
operation and is used to retrieve data from a list.

From String Enter a value to specify where to start retrieving data, with
single or double quotation marks.

To String Enter a value to specify where to end retrieving data, with

single or double quotation marks.

The following field is displayed when Table, View or TC in the Table Type list, and ListDelete in
the Query Type list are selected.

Handle

String

Specify the handle which is generated by the ListCreate
operation and is used to delete a list.

Output

The following table describes the output elements in the Output tab of the QueryXMLList activity.

Output Item

The following fields are displayed when Table, or View in the Table Type list, and ListCreate in the
Query Type list are selected.

Data Type

Description

Status Boolean The status of the QueryXMLList activity. If it runs
successfully, the status is true; otherwise, the status is
false.

ID String The ID number of the returned message.

Message String The return message after running the QueryXMLList
activity.

TableName String The name of the table where ListCreate operations are
performed.

Handle String The unique identifier which is used to retrieve data or
delete a list.

Session String The session and its value in the process.

Size Int The size of the data in bytes.
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Output Item Data Type Description
ReturnCode String The return code after running the QueryXMLList
activity.

The following fields are displayed when TC in the Table Type list and ListCreate in the Query Type
list are selected.

Status Boolean The status of the QueryXMLList activity. If it runs
successfully, the status is true; otherwise, the status is
false.

D String The ID number of the returned message.

Message String The return message after running the QueryXMLList
activity.

TCName String The name of the TC where ListCreate operations are
performed.

Handle String The unique identifier which is used to retrieve data or

delete a list.

Session String The session and its value in the process.

Size Int The size of the data in bytes.

ReturnCode String The return code after running the QueryXMLList
activity.

The following fields are displayed when Table, or View in the Table Type list, and ListRetrieve in
the Query Type list are selected.

Status Boolean The status of the QueryXMLList activity. If it runs
successfully, the status is true; otherwise, the status is
false.

ID String The ID number of the returned message.

Message String The return message after running the QueryXMLList
activity.

TableName String The name of the table where ListRetrieve operations are
performed.

Handle String The unique identifier which is used to retrieve data
from a list.

ReturnCode String The return code after running the QueryXMLList
activity.

The following fields are displayed when TC in the Table Type list and ListRetrieve in the Query
Type list are selected.
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Output Item Data Type Description

Status Boolean The status of the QueryXMLList activity. If it runs
successfully, the status is true; otherwise, the status is
false.

ID String The ID number of the returned message.

Message String The return message after running the QueryXMLList
activity.

TCName String The name of the TC where ListRetrieve operations are
performed.

Handle String The unique identifier which is used to retrieve data
from a list.

ReturnCode String The return code after running the QueryXMLList

activity.

The following fields are displayed when Table, View or TC in the Table Type list and ListDelete in
the Query Type list are selected.

Status Boolean The status of the QueryXMLList activity. If it runs
successfully, the status is true; otherwise, the status is
false.

ID String The ID number of the returned message.

Message String The return message after running the QueryXMLList
activity.

TableName String The name of the table where ListDelete operations are
performed.

Handle String The unique identifier which is used to delete a list.

ReturnCode String The return code after running the QueryXMLList
activity.

Fault

The following table describes the error schema elements in the Fault tab of the QueryXMLList activity.

Error Schema Element Data Type Description
JDEPluginException
msg String This error message is displayed when the JD Edwards

EnterpriseOne plug-in captures an exception for the
QueryXMLList activity.
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Error Schema Element Data Type Description

msgCode String This error code is displayed when the JD Edwards
EnterpriseOne plug-in captures an exception for the
QueryXMLList activity.
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Working with the Sample Project

Working through the sample project helps you understand how TIBCO ActiveMatrix BusinessWorks
Plug-in for JD Edwards EnterpriseOne operates.

TIBCO ActiveMatrix BusinessWorks Plug-in for JD Edwards EnterpriseOne is packaged with a sample
project within the installer. After installing the plug-in, you can find the sample project which is located
in the TTBCO_HOME\bw\palettes\jde\version number\samples directory.

Importing the Sample Project

Before running the project, you must import it to TIBCO Business Studio.

Procedure

1. Start TIBCO Business Studio using one of the following ways:

*  Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers

. Mac OS and Linux: run the TIBCO Business Studio executable file located in the TTBCO_HOME/
studio/version_number/eclipse direCtOI‘y.

From the menu, click File > Import.

In the Import window, expand the General folder and select the Existing Studio Projects into
Workspace item. Click Next.

4. Click Browse next to the Select archive file field to select the JDEExample.zip file. Click Finish.

The JDEExample. zip file is located in the TTBCO_HOME\bw\palettes\jde\version_ number
\samples directory.

Result

The sample project is imported to TIBCO Business Studio.

Ly Project Explorer &2 = O

&S T
w [Eﬁ_ JDEExample
fa& Processes
% Service Descriptors
2 Resources
(@ Schemas
4 ¢ Module Descrniptors
[ord build.properties
ﬁﬁ JDEExarnple.application
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Configuring the JDE Connection

Configuring the JDE Connection shared resource is essential for the plug-in to establish a connection to
the JD Edwards EnterpriseOne server.

Prerequisites
Importing the Sample Project.

Procedure

1. In the Project Explorer view, expand JDEExample > Resources.
2. Double-click JDEConnectionResource.JDEConnectionResource.

3. In JDE Connection Editor, configure each field accordingly.

4. On the toolbar, click the Save || icon to save your changes.

Running the Sample Project

The sample project shows how to use the plug-in to run one or a group of business functions, query
tables by XML lists, and monitor real time events in the JD Edwards EnterpriseOne system.

Prerequisites

Ensure that you have imported the sample project to TIBCO Business Studio, as described in Importing
the Sample Project, and configured JDE Connection, as described in Configuring the JDE Connection.

Procedure
1. In the Project Explorer view, expand the Module Descriptors resource, and then double-click

Components.

2. By default, all the processes are listed in the Components editor. Select the process that you do not

want to run and click the remove selected component @ icon.

3. On the toolbar, click the Save || icon to save your changes.
4. From the menu, click Run > Run Configurations to run the selected process.

5. In the Run Configurations dialog, expand BusinessWorks Application, and then click
BWApplication.

6. In the right panel, click the Applications tab, and select the check box next to
JDEExample.application.

7. Click Run to run the selected process.

8. Click the Terminate g icon to stop the process.

Configuration of Sample Processes
The example file contains one project. Each process in the project has different functions.

After importing the sample project, expand the project in the Project Explorer view. All the processes
are displayed. See Importing the Sample Project for more information.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for JD Edwards EnterpriseOne User's Guide



[ Project Explorer 52 | [0 ‘& | &

v [ JDEExample
v @ Processes

w F3 BusinessFunction
8 Customer.bwp

w [ BusinessFunctionGroup
8 SalesOrder.bwp

v 3 QueryXMLList_Table
£8 PurchaseOrder.bwp

v B QueryXMLList_TC
8 ¥MLQueryList_TC.bwp

v 3 QueryXMLList_VIEW
£8 SalesOrder.bwp

v 4 RealtimeEvent
8 Addressbook.bwp

% Service Descriptors

1z Resources

& Schemas

4 Module Descriptors

[ build.properties

% JDEExample.application

Customer.bwp

This process demonstrates how to use the plug-in to run a business function in the JD Edwards

EnterpriseOne system.

- = 0

The process is designed with the following activities:

BusinessFunction.Customer

K

Timer

CallBusinessFunction

The following table describes the activities in the process.

29
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Activity Description

Timer Starts the process.

Runs a business function in the JD Edwards EnterpriseOne
system.

CallBusinessFunction

SalesOrder.bwp

This process demonstrates how to use the plug-in to run a group of business functions in the JD
Edwards EnterpriseOne system.

The process is designed with the following activities:

B BusinessFunctionGroup.SalesOrder

o

Timer CallBusinessFunctionG
roun

The following table describes the activities in the process.

Activity Description

Timer Starts the process.

CallBusinessFunctionGroup Runs a group of business functions in the JD Edwards
EnterpriseOne system.

PurchaseOrder.bwp
This process demonstrates how to use the plug-in to perform a query operation in the specified Table.

The process is designed with the following activities:

B QueryXMLList_Table PurchaseOrder

Timer Createlist Retrievelist Deletelist

The following table describes the activities in the process.
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Activity Description

Timer Starts the process.

CreateList Creates a query list for the specified Table in the JD
Edwards EnterpriseOne system.

RetrieveList Retrieves data from the JD Edwards EnterpriseOne system
according to the query list.

DeleteList Deletes the query list from the JD Edwards EnterpriseOne
system after the query operation is completed.

XMLQueryList_TC.bwp

This process demonstrates how to use the plug-in to perform a query operation in the specified TC.

The process is designed with the following activities:

= QueryXMLList_TC.XMLQueryList_TC

—p M —p

Timer Createlist Retrievelist Deletelist

The following table describes the activities in the process.

Activity Description

Timer Starts the process.

CreateList Creates a query list for the specified TC in the JD Edwards
EnterpriseOne system.

RetrieveList Retrieves data from the JD Edwards EnterpriseOne system
according to the query list.

DeleteList Deletes the query list from the JD Edwards EnterpriseOne
system after the query operation is completed.

SalesOrder.bwp

This process demonstrates how to use the plug-in to perform a query operation in the specified View.

The process is designed with the following activities:
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=] QueryXMLList_ VIEW.SalesOrder
= o9 o
& m
Timer Createlist Retrievelist Deletelist

The following table describes the activities in the process.

Activity Description

Timer Starts the process.

CreateList Creates a query list for the specified View in the JD
Edwards EnterpriseOne system.

RetrieveList Retrieves data from the JD Edwards EnterpriseOne system
according to the query list.

DeleteList Deletes the query list from the JD Edwards EnterpriseOne
system after the query operation is completed.

Addressbook.bwp

This process demonstrates how to use the plug-in to monitor the real time event created by the JD
Edwards EnterpriseOne system.

The process is designed with the following activity:

B RealtimeEvent.Addressbook

D
=
-

[LIVE ]

A—
MonitorRealTime

s
a

The following table describes the activity in the process.

Activity Description

MonitorRealTime Monitors the real time event created by the JD Edwards
EnterpriseOne system.
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Managing Logs

When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.
By default, error logs are displayed in the Console view when you run a process in debug mode. You
can change the log level of the plug-in to trace different messages and export logs to a file. Different log
levels correspond to different messages, as described in Log Levels.

Log Levels
Different log levels include different information.

The plug-in supports the following log levels.

Log Level Description

Trace Includes all information regarding the running process.
Debug Indicates a developer-defined tracing message.
Info Indicates normal plug-in operations. No action is required. A tracing message

tagged with Info indicates that a significant processing step is reached, and
logged for tracking or auditing purposes. Only info messages preceding a
tracking identifier are considered as significant steps.

Error Indicates that an unrecoverable error occurred. Depending on the severity of
the error, the plug-in might continue with the next operation or might stop.

Setting Up Log Levels
You can configure different log levels for the plug-in and plug-in activities to trace different messages.

If you do not change any log levels, the plug-in uses the default log level of TIBCO ActiveMatrix
BusinessWorks. The default log level is Error.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open
the logback.xml file.

2. Add the following node in the BusinessWorks Palette and Activity loggers area to specify a log
level for the plug-in:

<logger name="com.tibco.bw.palette.jde.runtime">
<level value="DEBUG"/>
</logger>

The value of the 1evel element can be Error, Info,Debug or, Trace.

& If you set the log level to Debug, the input and output for the plug-in activities are also
displayed in the Console view. See Log Levels for more details regarding each log level.

3. Optional: Add different nodes in the User loggers area to specify different log levels for the
activities:

*  For the CallBusinessFunction and QueryXMLList activities, add the following node to set the
log level to Debug:

<logger name="com.tibco.bw.palette.jde.runtime.ActivityNameActivity">
<level value="DEBUG" />
</logger>
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e  For the MonitorRealTime activity, add the following node to set the log level to Debug:

<logger name="com.tibco.bw.palette.jde.runtime.MonitorRealTimeEventSource">
<level value="DEBUG"/>
</logger>

The activities that are not configured with specific log levels use the log level configure
% h h figured h specific log level he log level figured
for the plug-in.

4. Save the file.

Exporting Logs to a File

You can update the logback.xml file to export plug-in logs to a file.

Procedure

1. Navigate to the TIBCO_HOME\bw\version_number\config\design\logback directory and open
the logback.xml file.

After deploying an application in TIBCO Enterprise Administrator, navigate to the
TIBCO_HOME\bw\version_number\domains\domain_name\appnodes\space_name
\node_name directory to find the logback.xml file.

2. Add the following node to specify the file where the log is exported:
<appender name="FILE" class="ch.qos.logback.core.FileAppender">
<file>c:/bw6-jde.log</file>
<encoder>
<pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger{36}-%msg%n</pattern>
</encoder>
</appender>

The value of the file element is the absolute path of the file that stores the exported log.

3. Add the following node to the root node at the bottom of the logback.xml file:

<root level="DEBUG">
<appender-ref ref="STDOUT"/>
<appender-ref ref="FILE"/>
</root>

4. Save the file.
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Error Codes

The following table lists error codes, detailed explanation of error codes, and where applicable, ways to
solve different errors.

Error Code and Error

Message Category Description Solution
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when No.
JDE-500002 retrieving XML
) output for an activity.
IOException occurred
while retrieving XML
Output for activity
[{0}].
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when an No.
JDE-500003 execution method is
i invoked for an
Exception occurred . .
. . activity.
while invoke execute
method for activity
[{0}].
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when the Check if the
JDE-520001 business function is business function
. null. name is null.
The business
function should not
be null.
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when the Keep the business
JDE-520002 business function function name and
The business Va.lue is not consistent schema value
] ] with the schema consistent.
function value is
value.
not consistent with
schema.
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when the table  Set the correct table
JDE-540001 name is null. name.
The table name
should not be null
TIBCO-BW-PALETTE- Error BW-Plug-in Occurs when the No.
JDE-560001 activity is executed.
Exception occurred
while execute the
activity [{0}].The
error message is:{1}
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